University of Maine System
PeopleSoft General Ledger

PeopleSoft Financials 8.4

Excel Journal Entry
# TABLE OF CONTENTS

1. PEOPLESOFT FINANCIALS GENERAL LEDGER .................................................. 4
2. EXCEL JOURNAL ENTRY PROCESS ................................................................. 4
3. INSTALL EXCEL FILES FOR ENTERING A JOURNAL ENTRY ..................... 5
4. ESTABLISHING EXCEL WORKBOOK FILE .................................................. 6
5. SET UP AND CONFIGURATE THE WORKBOOK FILE ............................. 7
   - Spreadsheet Journal Import Screen ....................................................... 7
   - General Section: Setup ..................................................................... 9
   - Review the ChartField Configuration Screen .................................. 12
6. ESTABLISH A NEW JOURNAL ENTRY WORKSHEET ............................. 14
   - Enter the Journal Sheet Name ............................................................ 14
   - New Journal Sheet ......................................................................... 15
7. ENTER A NEW JOURNAL HEADER ............................................................ 15
   - Edit Journal the Header .................................................................. 18
8. ENTER JOURNAL LINES ............................................................................ 19
   - Enter the Business Unit ................................................................... 20
   - Enter the Ledger ........................................................................... 20
   - Enter the Journal Line Description .................................................. 21
   - Enter the Journal Line Amount ......................................................... 21
9. ENTER THE JOURNAL LINE CHARTFIELDS ............................................ 22
   - Enter the Dept ID .......................................................................... 22
   - Enter the Account .......................................................................... 22
   - Enter the Class ............................................................................... 23
   - Enter the Fund ............................................................................... 23
   - Enter the Program ........................................................................... 24
   - Enter the Project ............................................................................ 24
   - Enter the Operating Unit ................................................................. 25
   - Enter the Reference ....................................................................... 25
   - Enter the Open Item Key ................................................................. 26
   - Currency, Rate Type, Rate and Base Amount Columns .................. 26
10. ADD JOURNAL LINES ............................................................................... 27
    - Add One Line at a Time .................................................................. 27
    - Add More Than One Line at a Time ................................................ 27
11. UPLOAD JOURNAL ENTRY TO PEOPLESOFT ....................................... 29
    - Write Journal Entry to File ............................................................. 29
    - Login to PeopleSoft ....................................................................... 31
    - Create a Run Control ID .................................................................. 32
12. IMPORT JOURNAL ENTRY ................................................................. 36
   Run the Import Process ............................................................ 36
13. CORRECT IMPORT ERRORS ......................................................... 40
   Possible Errors ........................................................................ 40
   Identify Errors ...................................................................... 40
14. OPEN AND EDIT EXISTING JOURNAL ENTRY SHEET .................. 42
15. COPY JOURNAL SHEETS ............................................................. 43
16. DELETE JOURNAL SHEETS .......................................................... 45
   To delete a journal sheet, open the spreadsheet journal import screen and click on the button .......... 45
17. ONLINE JOURNAL ENTRY TERMS AND CONCEPTS ..................... 46
1. PeopleSoft Financials General Ledger

The PeopleSoft General Ledger is a central financial database with built-in accounting, budgeting, financial analysis, and reporting features. It is built to handle multiple financial systems within a single database. This reduces redundancy, maintenance, and data integrity problems since all transactions are entered into one system.

2. Excel Journal Entry Process

Journal Entries are used to update the General Ledger for many types of transactions, including cash receipts, transfers of revenue or expense, and budget changes. The Spreadsheet Journal Entry system facilitates Journal Entry using Microsoft Excel. The customized Excel interface provides an easy-to-follow menu for entering data and specifying defaults.

- **Originator enters Journal Entry (JE) into customized PeopleSoft provided Excel Workbook.**
- **After JE is imported, Originator logs into PeopleSoft and uploads/imports Excel Journal Entry.**
- **Originator runs Edit process to check JE for errors, then submits the JE for Approval.**
- **Reviewer checks JE and either approves or denies it. If denied, Workflow moves it to Originator’s Worklist for correction and re-submittal. If approved, Workflow moves it to Final Approver’s Worklist.**
- **Final Approver reviews JE and either approves or denies it. If denied, Workflow moves it back to Reviewer’s Worklist for correction and resubmittal. If approved, it is marked for posting.**
3. Install Excel Files for Entering a Journal Entry

The first step towards using the Excel Journal Entry system is to install three required PeopleSoft provided Excel files on your computer. The files can be downloaded from [http://www.maine.edu/peoplesoft/train/excelfiles.html](http://www.maine.edu/peoplesoft/train/excelfiles.html).

The file names are **JRNLU MS.xls** (Journal Entry Workbook), **GLLOG.xlt** (message log template) and **JRNLMCRO.xla** (compiled macro sheet). The only file you will manipulate is the JRNLU MS.xls file. It is the Control page you will use to create and maintain Journal Entry sheets. **It is required that all three files be saved to the same directory on your workstation.** We recommend you create a folder on your workstation’s C: drive and download the three files into this folder. The in the “My Documents” section of the C: drive might be a convenient location.

![Image of My Documents]

**My Documents**

- **ExcelJournal Entry Training**
  - Microsoft PowerPoint Presentation
  - Modified: 10/7/2004 11:06 AM
  - Size: 6.91 MB
  - Attributes: (normal)
4. Establishing Excel Workbook File

We recommended you save the JRNLUMS.xls file and apply a different name to it. This will enable you to use the newly named workbook file for your Journal Entries and retain a clean copy of the JRNLUMS.xls file readily available in case you need it. You can also download the original version from the location site above, if you wish.

Before using the PeopleSoft provided Excel files, make certain the Excel Macro Security Level is set to **Medium** rather than **High**.

To check the Macro Security settings, open Excel and, select **Tools > Macro > Security** from the Excel menu.

To open the PeopleSoft Excel workbook file, choose **File > Open** from the Excel menu. Locate file **JRNLUMS.xls** from the location you saved it to on your workstation and open it. Click on the **Enable Macros** dialog box when it appears and the Excel file will open.

Now you can save and rename the **JRNLUMS.xls** file. Choose **File > Save As** from the Excel menu. Save the file in the same folder on your workstation where the other PeopleSoft provided Excel files are located. Apply a new name to the file (i.e. “ExcelJournals”). After entering the new name, save the file and close it. Now when you open the folder you will see that the **JRNLUMS.xls** file and the file you just saved are in the same folder. They are exactly the same but with different names applied to them. As was explained above, you will use the file you saved and retain the **JRNLUMS.xls** file as a back up.
5. Set Up and Configure the Workbook File

From your Excel menu, open your Excel Journal workbook file and click on the Enable Macros button when it appears. The Spreadsheet Journal Import screen will open. You will most likely need to adjust the window to view the entire screen.

Spreadsheet Journal Import Screen

The Spreadsheet Journal Import screen provides links to other screens you will use during the initial setup of your Excel Journal Entry worksheet. It is comprised of three main sections that provide you with various options. The sections are:
**General** - There are two buttons in the General section. They are **Setup** and **Notes**.

**Setup** is used for a one-time setup of the general default options for your Excel Journal Entry worksheets. Setup also provides the option to arrange the ChartField columns on your Journal Entry worksheets in an order that best suits your needs.

**Notes** is an Excel worksheet that you may use for miscellaneous notes or calculations. Use of Notes is optional and it is not linked to any specific Journal Entry worksheet.

**Journal Sheets** - Journal Sheets are the Excel worksheets you will setup to enter and hold your Excel Journal Journal Entries. To avoid confusion in naming Journal Sheets and Journal Entries, and in writing and uploading the journal sheets, it is best to enter just one Journal Entry on each Journal Sheet and give them the same name. The Journal Sheets section of Spreadsheet Journal Import screen provides four options for managing your Journal Sheets. They are:

- **New** – This button opens a new Journal Sheet
- **Edit** - Enables you to select already entered Journal Sheets so you can apply edits to them
- **Delete** – Enables you to delete Journal Sheets
- **Copy** – Enables you to copy Journal Sheets.
**Import Journals** - The Import Journals section contains two buttons, **Import Now**, and **Write File**.

You will not use the **Import Now** option. Rather, you will use **Write File** to prepare your Excel Journal Entries for transfer to PeopleSoft, upload the files into PeopleSoft and import the Journal.

**General Section: Setup**

As was explained above, the **Setup** section is where you will set the general default options for your Journal Entry worksheets (Business Unit, Ledger Group, Source and User ID). When you select the Setup button, the **Define Options and Defaults** screen opens.
The **Define Options and Defaults** page is comprised of five sections:

1. **Header Defaults** - This is where you will set the Header defaults that will appear on your Excel Journal Entries. The Header contains information that uniquely identifies a Journal Entry.

   - **Business Unit** – Enter your five-digit Business Unit.
   - **Date** - Leave blank. When you create your Journal Entries worksheets, today’s default date will enter or you will assign an alternative date.
   - **Ledger Group** – Using upper-case text, enter the appropriate Ledger.
   - **Source** – Enter the three-digit Source assigned to you.
   - **User ID** - Enter numeric Employee ID.

2. **General Options**
   This section delivers English as default language.

3. **Message Options**

4. **Document Sequencing**

5. **Online Import Control**

---

Leaving these boxes unchecked is recommended.
3. Message Options
This section applies to Import Now function. Since we will not use that option to import journals, you can disregard this section.

4. Document Sequencing
Leave both boxes blank.

5. Online Import Control
All necessary settings will appear in this section by default. Do not adjust.

When you select the Configure button on the Define Options and Defaults screen, a Journal Entry worksheet and the ChartField configuration screen will display.

The first time you open your Journal Entry worksheet, the ChartField columns should appear in the same order they appear when you open a PeopleSoft online Journal Entry. You should only need to make changes to the worksheet column order if you prefer a different order. For example, if you know you will only use the same four or five ChartFields on every Journal Entry you create in Excel, you might want to move those four columns together.
You can use the **ChartField configuration** screen to arrange the Journal Entry worksheet columns in an order that best suits your needs.

Review the ChartField configuration screen

Settings applied via the **ChartField configuration** screen apply to all Journal Sheets set up after the configuration is set. If the configuration is changed, Journal Sheets set up after that change will reflect the new configuration.
Journal Sheets set up before the reconfiguration will remain unchanged; they will reflect the old configuration.

**Note:** You may skip the rest of the steps in this section if your Journal Sheet is already properly configured.

**ChartField configuration screen options:**

- Moves blue vertical selection bar LEFT
- Moves blue vertical selection bar RIGHT
- Moves selected column to the LEFT
- Moves selected column to the RIGHT
- Inserts New column to LEFT of blue column
- Deletes selected column

**DO NOT ADJUST COLUMN WIDTHS.** Column widths are set to accommodate cut and paste instructions contained in Excel macros. Adjusting certain column widths will cause macros to fail when attempting to add a line for a Journal Entry.

**DO NOT** delete the following columns from your worksheet: Rate Type, Rate and Base Amount. We will not use these columns, but we are not allowed to delete them.

When you select the Field Format tab of the ChartField configuration box, the following screen opens:
The **Field Format** screen shows the **Field name, Label** and **Format** of each column description required to properly transfer Excel Journal Entries to PeopleSoft. **Do not make any changes to field format settings.**

Select the **Column** tab on the **ChartField configuration** box and then select **Exit** to return to the **Spreadsheet Journal Import** screen.

Save your Work by clicking on the **(Save)** button on your Excel Menu Bar.

**6. Establish a New Journal Entry Worksheet**

From your Excel menu, open your Excel Journal workbook file and click on the **Enable Macros** button when it appears. It is recommended that you set up a new journal worksheet for each Excel Journal Entry you enter. The Journal Sheet name is the name you will site later when you upload your Journal Entry into PeopleSoft.

To set up a new Journal Sheet, from the **Journal Sheets** section of the **Spreadsheet Journal Import** screen, select the **New** button.

The **New Journal Sheet** dialogue box appears as shown below:

![New Journal Sheet Dialogue Box](image)

**Enter the Journal Sheet Name**

We recommend you name the Journal Sheet the required ten-character (maximum) Journal ID you plan to use for PeopleSoft. Do not use more than ten characters or enter spaces in the Journal Sheet Name. If you do, the Journal Entry will upload to PeopleSoft but it will fail the Edit process.
Select OK after you enter the Journal Sheet name to open New Journal Sheet.

**New Journal Sheet**

<table>
<thead>
<tr>
<th>E</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Spreadsheet Journal Import</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Header</td>
<td>Unit</td>
<td>Journal</td>
<td>Date</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Line</td>
<td>Line #</td>
<td>Unit</td>
<td>Ledger</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>+</td>
<td>-</td>
<td>+...</td>
<td>-...</td>
</tr>
</tbody>
</table>

The Journal Sheet Name will not appear on the Journal Sheet. You can only view the Journal Sheet Name on the list that displays when you select from the *Spreadsheet Journal Import* screen.

The name you will see on the Journal Sheet is the name you will apply to the Journal Header (we will enter the Journal Header below).

**7. Enter a New Journal Header**

In the **Header** section of the Journal Sheet, click in row 5.
The New Journal Header box opens:

Notice that all previously set Header defaults are entered and a Journal Date (by default, today's date) has been applied.

Enter the Journal ID. Again, to avoid confusion, we recommend the Journal ID and the Journal Sheet Name be the same.

Leave the Ledger, Journal Class, Transaction Code, Foreign Currency, Rate Type and Exchange Rate fields.

Enter the same date entered for the Journal Date in the Effective Date box.
After you enter all required information on the New Journal Header screen, select [ ] to return to the Journal Sheet which now shows the Header information you just entered.

In the Description box, enter your Journal Entry Description. You can enter up to 254 alpha/numeric characters.

Leave Adjustment Type box blank.

Adjusting Entries and Reversals are handled by only a few employees, so will not be covered here.
**Edit Journal the Header**

To change items in Journal Header, select the ![Edit Header icon](image) icon on Row 5 of the Header.

**IMPORTANT:** We recommend that you DO NOT use the buttons in Row 5 except for the *Edit Header* button. The row 5 buttons are used to enter multiple Journal Entries on a single Journal sheet. Due to many common pitfalls during the upload process of Journal sheets containing multiple Journal Entries, we DO NOT RECOMMEND you enter more than one Journal Entry per Journal sheet.

The **Edit Journal Header** selection box appears

![Edit Journal Header](image)

Select the Journal Sheet you want to Edit and select ![OK button](image). The **Edit Journal Header** box will appear:
Notice a “0” now appears in the Exchange Rate box. This is how you would enter changes to an established Journal Header. After you apply changes to the Header, select **OK** to return to the Journal Sheet.

To save your work when entering information into the Journal Sheet, click on the **(Save)** icon located on your Excel menu bar. From the Journal Sheet page, you do not need to return to the Spreadsheet Journal Import screen before saving your work.

### 8. Enter Journal Lines

We use Journal Entry Lines to record the transactions making up the Journal Entry – the debit and credit entries, and to enter ChartField information that describes details of the Journal Entry.
From Row 9 of Journal Sheet Lines section, select the button to enter the first line of your Journal Entry.

Notice that the Journal ID appears in the first column of the Journal Entry.

**Enter the Business Unit**

In the Unit column of Journal Line enter the five-character Business Unit for first line of the Journal Entry.

*Note:* The Business Unit must be entered in UPPER-CASE text.

**Enter the Ledger**

In the Ledger column of the Journal Entry Line enter “ACTUALS” in UPPER-CASE text.
Enter the Journal Line Description

In the **Description** column of the Journal Entry Line, briefly but precisely explain what this line of Journal Entry does. Limit your description to thirty alpha/numeric characters.

<p>| | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td><strong>Spreadsheet Journal Import</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td><strong>Header</strong></td>
<td>Unit</td>
<td>Journal</td>
<td>Date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>UMS05</td>
<td>COPIEROCT01</td>
<td>11/3/2004</td>
<td>Copier Charges to Depts</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>+</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>+</td>
<td>-</td>
<td>+...</td>
<td>-...</td>
<td>Select fields to copy from a previous line</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Enter the Journal Line Amount

Every line of every Journal Entry requires a value in the **Amount** column.

**Note:** Enter credit values as negative numbers and debit values as positive number; Do not enter dollar signs or commas; If cents are other than zero, enter a period after the dollar amount.

<p>| | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td><strong>Spreadsheet Journal Import</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td><strong>Header</strong></td>
<td>Unit</td>
<td>Journal</td>
<td>Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>UMS05</td>
<td>COPIEROCT01</td>
<td>12/1/2004</td>
<td>Copier Charges to Depts Oct FY04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>+</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td><strong>Line</strong></td>
<td>Line #</td>
<td>Unit</td>
<td>Ledger</td>
<td>Description</td>
<td>Amount</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>+</td>
<td>-</td>
<td>+...</td>
<td>-...</td>
<td>Select fields to copy from a previous line by marking the appropriate boxes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>COPIEROCT01</td>
<td>UMS05</td>
<td>ACTUALS</td>
<td>Copier Oct 04 Charges</td>
<td>(300.00)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
9. Enter the Journal Line ChartFields

The next step in the process will be to enter information into the ChartField columns.

**Note:** Remember, you do not need to memorize the PeopleSoft ChartField Combinations that replace FAST accounts. The FAST to GL Translate tool provides you with Basic and Advanced searches to Look Up ChartField Combinations and a Reverse Look Up feature that displays what FAST account is associated with ChartFields entered in PeopleSoft. You can access the FAST to GL Translate Tool from your PeopleSoft menu.

**Enter the Dept ID**

Every line of every Journal Entry requires Department. Enter the seven-digit Department for the first line of your Journal Entry in the DeptID column.

**Enter the Account**

Every line of every Journal Entry requires Account. Enter the five-digit Account for the first line of your Journal Entry into the Account column.
As a reminder: Asset accounts begin with 1; Liability accounts begin with 2; Fund Balance accounts begin with 3; Revenue accounts begin with 4; Expense accounts begin with 5 or 6; Transfers-In and Transfers-Out begin with 7 or 8

Enter the Class

If you use the two-digit **Class** in your Journal Entry, enter the two-digit number into the **Class** column.

**Class** values range from 00 through 99 and are defined by the user with the exception of several classes that have been specified for distinct purposes at some campuses. Check with your supervisor or the Financial Officer for your campus to review restrictions before using **Class**.

Enter the Fund

Every line of every Journal Entry requires **Fund**. Enter the two-digit Fund for the first line of your Journal Entry in the **Fund** column.
### Enter the Program

If you use the five-digit **Program** code in your Journal Entry, enter the five-digit number in the **Program** column.

<table>
<thead>
<tr>
<th>P</th>
<th>Q</th>
<th>R</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Enter the Project

If you use the seven-digit **Project** code in your Journal Entry, enter the seven-digit code in the **Project** column.

<table>
<thead>
<tr>
<th>P</th>
<th>Q</th>
<th>R</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You can use more than one Program or Project with a Department on a Journal Entry. You will need to enter a different Line for each different Program or Project, however.
Enter the Operating Unit

For lines on which you will include an Operating Unit in addition to a Department, enter the three-digit Operating Unit in the OperUnit column.

Remember to periodically save your work!

Enter the Reference

The Reference column allows you to refer each line of your Journal Entry back to a document, person, invoice or any other piece of information that will be helpful in tracking the source of your Journal Entry line. You may enter up to ten alpha/numeric characters in the line Reference column.
**Enter the Open Item Key**

**Open Item Key** is the identifying or search key for locating non-travel related open items. Travel-related advances will be handled through the *Travel and Expenses* module rather than with the Open Item Key. **Leave the Open Item Key field blank.**

![Image of Open Item Key]

---

**Currency, Rate Type, Rate and Base Amount Columns**

No information needs to be entered into last four columns of Journal Entry line, so you will leave those columns blank.

![Image of Currency, Rate Type, Rate and Base Amount Columns]
10. Add Journal Lines

There are two options to add lines to Journal Entry:

**Add One Line at a Time**

In the Line section of your journal sheet, select the + button in Row 9 to add one line to your Journal Entry.

<table>
<thead>
<tr>
<th>E</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This option copies information from previous line into new line for those columns checked in Row 8. *(See page 45 of this manual for information about Deleting Journal Entry lines.)*

**Add More Than One Line at a Time**

In Lines section of your journal sheet, click + button to open the Insert Multiple Lines dialog box:

In the Number of Lines field, enter number of lines you wish to add to your Journal Entry. By default, the new lines will be added below existing lines. You cannot add lines between already existing lines.
The new lines will be blank unless you check the **Copy data from line** box.

Another box will appear where you will enter the number of the line you want to copy data from. When you are finished, select the **Insert** button to add the new lines.

If necessary, you can apply changes to the information entered on your Journal Entry sheet by clicking in the cell/s you need to adjust and entering the appropriate data.

**Completed Journal Entry worksheet:**
11. Upload Journal Entry to PeopleSoft

When the Journal Entry is complete, it is time to prepare the worksheet for upload to PeopleSoft. From the Journal Spreadsheet Import screen, select **Write File.**

![Spreadsheet Journal Import](image)

**Write Journal Entry to File**

The **Write Journals to File** dialog box will appear. Click on the Journal Sheet you want to upload to PeopleSoft to select it.

![Write Journals to File](image)
In the **File name** box, enter the path (where on your computer you will save the file to) and the file name. Apply an **.xml** extension to the file rather than **.xls** extension. The file will still upload if you apply an .xls extension to it, but you will be able to retrieve more meaningful data about the file later on in the process if you apply an .xml extension to it. We will show examples of this later.

![Write Journals to File dialog box](image)

**Note:** Make certain to take note of the path you entered in the File name section since you will browse for that location later in the process.

After you select the **OK** button, your Excel Journal Entry will be saved on your computer as an .xml file and ready for upload to PeopleSoft.
**Login to PeopleSoft**

You must login to your PeopleSoft account to upload then Import Excel Journal Entries. After you login, follow this navigation to get to PeopleSoft **Spreadsheet Journal Import** page:

*University of Maine System > Financials > General Ledger > Journals > Import Journals > Spreadsheet Journals*

When you select **Spreadsheet Journals**, the **Spreadsheet Journal Import** page appears with the **Find and Existing Value** page open:
Create a Run Control ID

The first time you upload an Excel Journal Entry to PeopleSoft, you will need to create a Run Control ID. A Run Control ID is used whenever a process is run in PeopleSoft. You can save Run Controls for processes you frequently use.

To create a Run Control ID, select the Add a New Value tab.

Enter a name for the Run Control ID. It usually helps to apply a name that relates to the process you are creating it for. You will only see the Run Control IDs you create.

After you enter a name for the Run Control ID, select Add.

The Spreadsheet Journal Import page will open.

Note: You will select already created Run Control IDs from the “Find An Existing Value” page
All necessary information for the Excel Journal Entry upload process will appear on the page.

In the **Attached File** section, select the icon to browse for the .xml Journal Entry file you previously saved to your computer. When you select the icon, the following dialog box opens:

Select to open the **Choose File** dialog box.
This is how you can browse your computer to locate the .xml Journal Entry file you saved and then select it. After who choose the file, click on the Open button to enter the file name into the Browse dialog box.

Upload Journal Entry to PeopleSoft

Select the Upload button to return to the Spreadsheet Journal Import page with the file you selected entered in the Attached File section.
Prior to importing your attached file to PeopleSoft, click the button on the Spreadsheet Journal Import page. A file similar to the following will appear:

```
<JRNL_HDR_IMP>
  <BUSINESS_UNIT>UMSO5</BUSINESS_UNIT>
  <JOURNAL_ID>COPIEROCT04</JOURNAL_ID>
  <JOURNAL_DATE>20041103</JOURNAL_DATE>
  <DESCR254>Copier Charges to Depts Oct FY04</DESCR254>
  <LEDGER_GROUP>ACTIONS</LEDGER_GROUP>
  <SOURCE>501</SOURCE>
  <OPRID>90000001</OPRID>
  <CUR_EFFDT>20041103</CUR_EFFDT>
  <REVERSAL_CD>N</REVERSAL_CD>
  <AUTO_GEN_LINES>N</AUTO_GEN_LINES>
  <ADJUSTING_ENTRY>N</ADJUSTING_ENTRY>
</JRNL_HDR_IMP>

- <JRNL_LN_IMP>
  <JOURNAL_LINE>1</JOURNAL_LINE>
  <BUSINESS_UNIT>UMSO5</BUSINESS_UNIT>
  <LEDGER>ACTIONS</LEDGER>
  <LINE_DESCR>Copier Oct 04 Charges</LINE_DESCR>
  <FOREIGN_AMOUNT>-900</FOREIGN_AMOUNT>
  <DEPTID>5303100</DEPTID>
  <ACCOUNT>60699</ACCOUNT>
  <FUND_CODE>00</FUND_CODE>
  <JRNL_LN_REF>Copier4100</JRNL_LN_REF>
</JRNL_LN_IMP>

- <JRNL_LN_IMP>
  <JOURNAL_LINE>2</JOURNAL_LINE>
  <BUSINESS_UNIT>UMSO5</BUSINESS_UNIT>
  <LEDGER>ACTIONS</LEDGER>
  <LINE_DESCR>Copier Oct 04 Charges</LINE_DESCR>
  <FOREIGN_AMOUNT>300</FOREIGN_AMOUNT>
  <DEPTID>5303101</DEPTID>
  <ACCOUNT>60603</ACCOUNT>
  <FUND_CODE>00</FUND_CODE>
  <JRNL_LN_REF>Copier4100</JRNL_LN_REF>
```

You might want to access this file prior to importing your Journal Entry to PeopleSoft just to verify one more time that the information entered in the Journal Entry is correct.

If the file had been saved as an .xls file rather than an .xml file, most of the information would be encoded and not discernable to most people.
12. Import Journal Entry

Select the Run button and the Process Scheduler Request page will open.

Run the Import Process

Most of the required information will enter by default on the Process Scheduler Request page.
Complete the **Process Scheduler Request** page as follows:

**User ID:** By default, the User ID of the person who uploaded the file will appear.

**Run Control ID:** By default, the Run Control ID previously entered will appear.

**Server Name:** Enter **PSUNX** if it does not appear by default.

**Recurrence:** Leave **blank**.

**Time Zone:** Leave **blank**.

**Run Date:** By default, will show today’s date. Leave as is.

**Run Time:** By default, will show the current time. Leave as is.

**Process List:** Verify that Spreadsheet Journal Import ☑️ box is checked.

After you have reviewed all of the above items, select the **OK** button.

The **Spreadsheet Journal Import** page will appear with a Process Instance number assigned to it.

This indicates to you that the process to import your uploaded Excel Journal Entry file to PeopleSoft is submitted to run.

---

**Note:** You do not need to select the **Run** button on the Spreadsheet Journal Import page. The fact that you see a Process Instance # tells you your process is in line to be run.

---

Click **Process Monitor** on the **Spreadsheet Journal Import** page to check the progress and success of the process run. The **Process List** page appears:
In the **Instance Seq.** column, find the **Process Instance number** that appeared on the **Spreadsheet Journal Import** page. Locate it in the **Instance Seq.** column of the **Process List** page above. When you locate the number, read across the line it is on to the **Run Status** column and note a status of **Success** telling you the process instance for your Journal Entry has run.

To find out if your Excel Journal Entry was imported, click **Details** on the **Process List** page to access the **Process Detail** page that appears below:
Click [Message Log] to see the **Message Log** page that gives details of your process instance #1361. Note the third line of the log that tells you:

**Process completed successfully with 1 journals imported.** This indicates your Excel Journal Entry has been imported into PeopleSoft and it is ready to be edited, approved, and posted.

### Message Log

<table>
<thead>
<tr>
<th>Severity</th>
<th>Log Time</th>
<th>Message Text</th>
<th>Explain</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>3:40:55PM</td>
<td>Journal Import processing has started.</td>
<td>Explain</td>
</tr>
<tr>
<td></td>
<td>3:40:56PM</td>
<td>Processing file copier0507.xml ...</td>
<td>Explain</td>
</tr>
<tr>
<td></td>
<td>3:40:57PM</td>
<td><strong>Process completed successfully with 1 journals imported.</strong></td>
<td>Explain</td>
</tr>
<tr>
<td>10</td>
<td>3:40:57PM</td>
<td>Journal Import processing has finished.</td>
<td>Explain</td>
</tr>
<tr>
<td></td>
<td>3:41:01PM</td>
<td>Published message with Pub ID of 356 to request to have related report added in folder GENERAL</td>
<td>Explain</td>
</tr>
<tr>
<td></td>
<td>3:41:01PM</td>
<td>Successfully posted generated files to the report repository</td>
<td>Explain</td>
</tr>
</tbody>
</table>

**Caution:** It is important carefully check the message log because a Run Status of “Success” does not necessarily mean your Excel Journal was imported. A Run Status of Success can result in a message that says:

**Process completed successfully with 0 journals imported.**

In this case, while the process successfully brought your Excel Journal Entry over to PeopleSoft, it could not **import** the Journal Entry because it contained error/s.
13. Correct Import Errors

Possible Errors

The Excel Journal Entry you uploaded to PeopleSoft must contain valid ChartField values in order for PeopleSoft to import the Journal Entry. If your Excel Journal Entry contains a ChartField value that is not on the PeopleSoft Look Up pages it will not import.

An invalid PeopleSoft User ID entered on the Excel Journal Entry header will result in failure of the Excel Journal Entry to import.

An Excel Journal Entry with the same Business Unit/Journal ID/Journal Date combination as an already existing PeopleSoft Journal Entry will fail to import.

Identify Errors

If the **Message Log** page indicated your Journal Entry did not import click on the **Return** button on the Message Log page to return to the **Process Detail** page.

---

**Process Detail**

<table>
<thead>
<tr>
<th>Instance:</th>
<th>4646</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td>GL_EXCL_JRNL</td>
</tr>
<tr>
<td>Description:</td>
<td>Spreadsheet Journal Import</td>
</tr>
</tbody>
</table>

**Run Control ID**: IMPORTJE

**Location**: Server

**Server**: PSUNX

**Date/Time**

- **Request Created On**: 11/03/2004 8:36:02AM EST
- **Run Anytime After**: 11/03/2004 8:35:58AM EST
- **Began Process At**: 11/03/2004 8:36:27AM EST
- **Ended Process At**: 11/03/2004 8:36:32AM EST

**Actions**

- **Parameters**
- **Transfer**
- **Message Log**
- **Temp Tables**
- **Batch Timings**
- **View Log/Trace**

---

On the **Process Detail** page, click on the **View Log/Trace** link to go to the **View Log/Trace** page.
On the View Log/Trace page click the second link. A page will open that describes the error(s) in your Excel Journal Entry.

The adjacent example tells us a user ran a process to import an Excel Journal Entry, **Copier0504**, that already exists.

```
Spreadsheet Journal Import (GL_EXCL_JRNKL)
2004-11-06 08.36.27.000000
-------------------------------
Processing file Copier0504.xml ...
Journal COPIER0504 already exists. Skip this journal.
-------------------------------
Process completed successfully with 0 journals imported.
Imported these journals:
Updated these journals:
```

This means a Journal Entry with the same Business Unit/Journal ID/Journal Date combination is already in PeopleSoft. In this situation, the user should go back to the Journal Entry Sheet file to take a look at the Excel Journal Entry.
14. Open and Edit existing Journal Entry Sheet

To access and edit the file, From your Excel menu, open your Excel Journal workbook file and click on the Enable Macros button when it appears. The Spreadsheet Journal Import screen will open.

Once the Journal Entry sheet is open, In this situation, you would review the header information and compare it to the existing Journal Entry in PeopleSoft to determine if the failed Journal Entry is indeed a duplicate. You might find that the only duplication is in the Business Unit/Journal ID/Journal Date combination, but the lines of the two Journals Entries are indeed different. In that case, you would change the journal ID or Journal Date on the second Journal Entry so it is different from the existing PeopleSoft Journal Entry, **SAVE** your changes, and then repeat the **Write File** and upload to PeopleSoft process.
15. Copy Journal Sheets

To copy a Journal Sheet, open the **Spreadsheet Journal Import** screen and click on the **Copy** button.

The **Copy** button of the **Spreadsheet Journal Import** anchor screen allows you to select an existing Journal Entry sheet and copy it.

For example, if you previously created a Journal Entry sheet to charge October 2004 copying expenses to departments, you can use it as a basis for charging out the expenses for November 2004. Your October 2004 Journal Entry sheet will remain unchanged.

When the new Journal Sheet opens, notice it is EXACTLY like the Journal Sheet you copied which. You now need to change it so you can process the current charges.

<table>
<thead>
<tr>
<th></th>
<th>E</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td><strong>Spreadsheet Journal Import</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td><strong>Header</strong></td>
<td><strong>Unit</strong></td>
<td><strong>Journal</strong></td>
<td><strong>Date</strong></td>
<td><strong>Description</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>UMS05</td>
<td>COPERICT</td>
<td>11/02/2004</td>
<td>Copyier Charges to Dept Oct 04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td><strong>Line</strong></td>
<td><strong>Line #</strong></td>
<td><strong>Unit</strong></td>
<td><strong>Ledger</strong></td>
<td><strong>Description</strong></td>
<td><strong>Amount</strong></td>
<td><strong>Dept ID</strong></td>
<td><strong>Account</strong></td>
<td><strong>Class</strong></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>COPERICT</td>
<td>UMS05</td>
<td>ACTUALS</td>
<td>Copyier Oct 04 Charges:</td>
<td>(300.00)</td>
<td>5300100</td>
<td>60089</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>COPERICT</td>
<td>UMS05</td>
<td>ACTUALS</td>
<td>Copyier Oct 04 Charges:</td>
<td>300.00</td>
<td>5300101</td>
<td>60803</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>COPERICT</td>
<td>UMS05</td>
<td>ACTUALS</td>
<td>Copyier Oct 04 Charges:</td>
<td>300.00</td>
<td>5300102</td>
<td>60803</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>COPERICT</td>
<td>UMS05</td>
<td>ACTUALS</td>
<td>Copyier Oct 04 Charges:</td>
<td>300.00</td>
<td>5300103</td>
<td>60803</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Click on the header edit button in row 5 to change the header to match your new Journal Entry sheet name.

When you click on the button, the Edit Journal Header box opens where, in this case, you would assign a new Journal ID, the Journal Date (effective date) and the Description:

- **Journal ID:** CopierNov04
- **Journal Date:** 11/8/2004
- **Description:** Copier Charges to Depts Nov 04

Everything else on the Header stays the same. Click **OK** when finished with the Edit Journal Header box.
In the **Lines** section of the sheet, change dollar amounts for the departments that had June charges.

Add new lines for departments that received charges for the first time in November (*we previously covered adding lines on page 29 of this manual*). Delete lines of departments that had no November charges (or, leave them on the sheet for future use and change their amounts to $0 November). **To delete lines**, highlight the row/s you want to delete and then click on the **-** button in Row 9 of the Journal Entry sheet.

### 16. Delete Journal Sheets

To delete a Journal Sheet, open the Spreadsheet Journal Import screen and click on the **Delete** button.

To delete a single sheet, highlight the Journal Entry sheet you want to delete and then click on the **Delete** button.

If you intend to delete all of your journal sheets, you would click **All**.

Click on the **Cancel** button to return to the Spreadsheet Journal Import screen.
17. Online Journal Entry Terms and Concepts

In PeopleSoft Financials we use the following terms:

**Account** – Required five-digit PeopleSoft ChartField. Can be compared to what we currently refer to as Object Code in FAST system.

**Business Unit** – Required five-digit PeopleSoft ChartField. Each University Unit is a Business Unit. This ChartField represents high-level Business Unit-related information that can be shared during inter-Business Unit transactions.

**ChartFields** – Components that make up PeopleSoft’s Chart of Accounts. Each ChartField provides key information related to a transaction.

**ChartField Combination** – PeopleSoft ChartFields joined together in various combinations to tell the system specifically what to record about each financial transaction.

**Chart of Accounts** – Foundation of an accounting system. The PeopleSoft Chart of Accounts is made up of informational fields (see “ChartFields”) that provide the basic structure for financial transactions.

**Class** – An Optional two-digit PeopleSoft ChartField. It is user-defined and will enable users to further qualify the account on the transaction (e.g. advertising costs by newspaper – Kennebec Journal, Bangor Daily News, Portland Press Herald…).

**Component** – A group of related PeopleSoft pages.

**Department** – Required seven-digit PeopleSoft ChartField. It tracks information according to organizational structure within each Business Unit.

**FAST to GL Translate tool** – Will provide information about what ChartField Combination replaces an existing FAST Account.

**Fund** – Required two-digit PeopleSoft ChartField. Is used for financial reporting and will vary based on different types of Projects and Programs.

**Final Approver** – During the Journal Entry workflow process, the Final Approver reviews Journal Entries submitted for approval by Reviewers. The Final Approver determines whether or not to mark Journal Entries for posting or deny them.

**General Ledger** – Central financial database with built-in accounting, budgeting, financial analysis, and reporting features.

**Journal Header** – The header contains the information that uniquely identifies the journal Entry, the Business Unit, Journal ID, and Journal Date.

**Journal Entry** – A PeopleSoft accounting entry entered online or input from a feeder system (payables, receivables, asset management, and so on) to the general ledger. Replace what were called Journal Vouchers in FAST system. In
PeopleSoft, you can enter Journals through PeopleSoft-provided Excel spreadsheets or online in PeopleSoft Financials.

**Journal ID** – Each Journal Entry needs to have a Journal ID either manually or automatically assigned to it. Manually entered Journal IDs may consist of up to ten alpha/numeric characters. Automatically assigned Journal IDs will consist of ten digits.

**Journal Lines** – Journal lines record the monetary amounts and the cost center values associated with each Journal Entry.

**Operating Unit** – Optional three-digit PeopleSoft ChartField. Can be used with Department to indicate a location, such as a center or campus within a Business Unit.

**Originator** – At the start of the Journal Entry workflow process, the Originator enters, edits and submits Journal Entries.

**Page** – PeopleSoft display and data entry screens.

**Program** – Sometimes required five-digit PeopleSoft ChartField. It is used to track expenses and revenues regarding gifts, endowments, loans and other sources of funds that need to be tracked across multiple departments, programs or Business Units.

**Project** – Sometimes required seven-digit PeopleSoft ChartField. It is required for all capital projects, grants & contracts and any other projects that have specific begin/end dates or that cross fiscal years.

**Reference** – On the Journal Entry Lines page, Reference allows you to refer each line of your Journal Entry back to a document, person, invoice or any other piece of information that will helpful in tracking the source of your Journal Entry line. You may enter up to ten alpha/numeric characters in the Journal Entry line Reference.

**Reference Number** - The Reference Number on a Journal Entry Header enables you to refer the Journal Entry back to a document, person, invoice or any other piece of information that will be helpful in tracking the source of your Journal Entry. You may enter up to eight alpha/numeric characters in the Journal Header Reference Number.

**Reviewer** – During the Journal Entry workflow process, the Reviewer (usually a supervisor) reviews Journal Entries submitted by Originator (an employee) and determines whether to approve, deny or request changes to the Journal Entry.

**Workflow** – Is the automation of a PeopleSoft business process (e.g. Journal approval). It essentially passes work from one participant in the process to the next. Rules are set up that determine workflow paths.

**Worklist** – The automated to-do list Workflow creates. PeopleSoft tool which enables you to view tasks that require your attention.